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This document is a project deliverable from the “EcoLogistics: Low carbon freight for sustainable cities”
project.
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policies to promote low carbon and sustainable urban freight in Argentina, Colombia and India,
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¢ India: Kochi, Shimla, Panaji
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1. Introduction

1) Background and objectives

The EcoLogistics self-monitoring tool is developed through the “EcoLogistics: Low carbon freight for
sustainable cities” project that is funded by the German Federal Ministry for the Environment, Nature
Conservation and Nuclear Safety (BMU) through the International Climate Initiative (IKI).

The tool can be utilized directly by cities to measure the existing greenhouse gas (GHG) emission
performance of urban freight using CO, equivalent (CO.e) values. It can also be used to estimate
urban freight emissions in the business-as-usual scenario and allows the assessment of a target
scenario wherein specific technologies or strategies that would improve fuel efficiency or reduce GHG
emissions are hypothetically implemented. The tool allows cities to make meaningful comparisons
over time and with other cities in terms of urban freight emissions.

The self-monitoring tool is an open, Excel-based tool. This guide provides guidance on how to use the
tool in connection to the databases and the most basic questions of emission calculations.

Box 1 Definition of “City” in this user guide

The term “city” in this user guide refers to geographically discernable subnational entities, such as
metropolitan areas, cities, towns, communities and neighborhoods. It is also used to indicate all
levels of subnational jurisdiction and local governments as legal entities of public administration.

Source: World Resources Institute, C40 Cities Climate Leadership Group, ICLEI - Local Governments for
Sustainability (ICLEI), Global Protocol for Community-Scale Greenhouse Gas Emission Inventories
(GPC). (2014).

2) Scope

The scope of the tool is limited to the calculation of emissions from urban freight transport
operations. It includes road, rail and inland waterway freight transport. Other logistics activities may
contribute additionally to overall freight emissions but are not addressed at this time and may be
calculated in the future updates as new information or data becomes available.

Carbon dioxide (CO,) is the most common GHG emitted and comprises the majority of emissions for
freight and logistics activities, whereas carbon dioxide equivalent (CO,€) is a unit used to represent
the global warming impact of various GHGs. Both are the standard references by which emissions are
measured and are used throughout this document.

3) System boundaries

When accounting the GHG emissions of fuel used in freight vehicles, the tool includes emissions from
the full life cycle, which are often referred to as well-to-wheel (WTW) emissions. WTW emissions are
equivalent to the sum of indirect emissions known as well-to-tank (WTT) and direct emissions as
tank-to-wheel (TTW) emissions. Figure 1 below illustrates the system boundaries considered under
the self-monitoring tool.

It must be noted that indirect energy consumption and indirect emissions from the manufacture,

construction, maintenance and disposal of vehicles or traffic infrastructure are excluded from the
calculation.

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 1



Figure 1 System boundary and calculation approach considered under the tool
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2. Application modes

This section introduces the input modes of the tool calculation front-end and the underlying
parameters. Before you start, it is important to know:

e This tool works best using Microsoft Excel 2007 and up. Features might be lost if previous
versions or Microsoft Excel for Mac are used.

¢ In any of the worksheets, users must only change or add values to the yellow and white cells.

¢ In any of the worksheets, you can go back to the homepage by clicking the home icon at the
upper right corner of the sheet.

The tool provides a standardized interface and comprises of the following tabs:

1.  Home (excel sheet tab is colored green)
2. City profile (tab is colored green)
3. Mode of transport (tabs are colored green)
e Road freight transport
e Rail freight transport
e Inland waterways transport
4, Forecast (tab is colored green, the following tabs are colored grey)
e Fuel technology change
e Distance reduction
e Eco-driving
e  Off-hour deliveries (also known as “out of hours” deliveries)
5. Results (tab is colored green)

Several worksheets are hidden, which contain back-end calculations and lists of default parameters.
You can display hidden worksheets as needed by following the steps: On the Home tab, in the Cells
group, click Format > Visibility > Hide & Unhide > Unhide Sheet. You'll be presented with a dialog box
listing the sheets that are hidden, and you can select the one you want to unhide.

To start your calculation, you can follow the steps below:

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 2



Figure 2 Steps in emission calculation and projection

Step 1
Fill in the baseline data

« Start with entering your baseline
data in the road tab, rail tab and
inland waterways tab

Step 2
See the baselineresults

+ The basic data will then allow you
to estimate the emission
performance of urban freight using
CO, and CO,e values in the results
tab

Step 3
Project GHG emissions

« You will gain insight into your fleet's
future emissions from road freight

Step 4
View your options

+ You will be able to review possible
technologies and strategies and its

transport in the forecast tab potential emission reductions

1) Home tab

The “Home" tab contains the introduction of the EcolLogistics self-monitoring tool and provides an
overview of the functionalities. As illustrated in Figure 3 below, each icon on the home tab redirects

" u n " ou

users to its respective tab: “City profile”, “Road transport”, “Rail transport”, “Inland waterway transport”

and “Results”. “Impact assessment” button redirects users to a list of pre-defined solutions that would
potentially reduce the environmental impact of urban freight transport.

Figure 3 Interface of “Home” tab
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2) City profile tab

The city profile tab is designed to highlight the freight characteristics and transport activities in the
urban contexts, along with dimensions of city size, geographic location and demographics. It also
outlines the air quality index (AQIl) and key pollutants, which is used for monitoring air pollution.

The yellow cells indicate that they are mandatory input cells, while the white cells suggest that they
are optional. It should be noted that the data items on this tab are common to all cities and they
contribute to the existing body of knowledge on urban freight transport. However, they are not key
parameters for emission calculation. Many cities may have trouble finding reliable information about
freight transport activities or tons of goods lifted for journeys within, to, through and from the city. As

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 3



efforts to improve data accuracy continue to expand, users may move forward to other tabs for
emission calculation.

Figure 4 Interface of “City profile” tab
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City properties

e City: Fill in your city name

e  Country: Fill in your country name

e Region: Choose from a dropdown menu of the following regions: Africa; East Asia; Europe;
Latin America & Caribbean; North Africa, Middle East and West Asia; North America; Oceania;
South Asia; Southeast Asia. It should be noted that uplifted values will be applied to emission
intensity factors for local conditions in Asia and Africa. For a detailed explanation please refer
to the road section.

e Climate: Fill in the climate type as per KGppen climate classification, one of the most widely
used climate classification systems, e.g., Rosario, Argentina has a Pampean, humid
subtropical climate (Cfa/Cwa). In contrast, Bogotd, Colombia has a subtropical highland
climate (Képpen Cfb).

e Area: Measured in square kilometer (km?)

e Boundaries: Choose between geographic or administrative boundaries. Any geographic
boundary may be used to understand where emissions are coming from and to indicate
where it can take action or influence change. In some cases, the boundary can align with the
administrative border of a local government, a metropolitan area, or another geographically
identifiable entity (GPC).

City parameters
In the city parameters section, most of the data items vary over the modeled years.

1) Socio-economic data
e Year: You can fill in the base year and the modelled years in this section, e.g., if the data is
collected from 2019, this will be the base year which your city’s emissions are tracked and

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 4




compared over time, as well as the base year for impact assessment and emission
projections.

e Population: Historical and forecast population data in terms of thousand (k)

e Gross Domestic Product (GDP): Historical and forecast GDP defined in terms of million
dollars (USD)

e Population growth rate (%): Annual population growth rate

2) Transport data — further divided into heavy goods vehicles (HGV, with a gross vehicle weight of

3.5 tons or more) and light goods vehicles (LGV, with a GVW up to and including 3.5 tons)

e Number of registered vehicles: Number of vehicles registered within the city in terms of
thousand

e Annual vehicle registration growth rate: Percentage of vehicles/year

e Total urban freight (within): The number of goods transported within the city

e Total urban freight (From): The number of goods transported from within the city boundary to
outside the city boundary

e Total urban freight (To): The number of goods transported from outside the city to the city

e Total urban freight (Through): The number of goods transported in the trips that pass through
the city, with both origin and destination outside the city

3) Total emission reduction target — Target of emission reductions from air, road, rail and inland
waterway transport, expressed in percentage (%) of ton/year

Air quality data

On-road diesel vehicles accounted for 60 percent of transportation-attributable fine particulate matter
(PM,s) in the EU and were responsible for nearly half of the health impacts of air pollution from
vehicles worldwide in 2015". Targeting emissions from on-road diesel vehicles could generate
substantial benefits for public health because these vehicles account for such a high proportion of
the city’s transportation attributable to deaths from air pollution. Thus, this section is included.

Air Quality Index (AQI) is an internationally uniform index for reporting and forecasting daily air quality.
It is divided into six categories and it uses a normalized scale from 0 to 500. The color-coded Table 1
below shows how the AQI values correlate with different levels of health concern and cautionary
statements, developed by the United States Environmental Protection Agency (EPA). Users may
search for city air pollution levels from existing platforms, such as the World Health Organization
(WHO)'s Global Platform on Air Quality and Health*.

Table 1 The Air Quality Index, levels of health concerns and cautionary statements

Index Levels of health | Cautionary statements
values concern

51-100 Moderate Unusually sensitive people should consider reducing prolonged or
heavy exertion outdoors.
101 - 150 Unhealthy for Active children and adults, and people with lung disease, such as

sensitive groups asthma, should reduce prolonged or heavy exertion outdoors.
Unhealthy Active children and adults, and people with lung disease, such as
asthma, should avoid prolonged or heavy exertion outdoors. Everyone

else, especially children, should reduce prolonged or heavy exertion
outdoors.

! International Council on Clean Transportation. A Global Snapshot of The Air Pollution-Related Health Impacts of
Transportation Sector Emissions in 2010 and 2015. (2019). Retrieved from
https://theicct.org/publications/health-impacts-transport-emissions-2010-2015

% The Global Platform on Air Quality and Health combines ground station monitoring with satellite data for a
comprehensive view of air pollution levels in over 4000 cities. Retrieved from https://breathelife2030.0rg/the-
issue/air-quality-in-your-city/

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 5



Very unhealthy [ Active children and adults, and people with lung disease, such as
asthma, should avoid all outdoors exertion. Everyone else, especially

children, should reduce prolonged or heavy exertion outdoors.

301 -500 | Hazardous | Everyone should avoid all physical activity outdoors.

The concentration levels of key air pollutants are required in the section. WHO recommends guideline
values for each type of pollutant. Details can be found on its website®.

Table 2 Data inputs in the AQI section

Air pollutants | Description [ Unit______| WHO guideline values

Fine particulate matter Particles with a Micrograms 10 pg/m?® annual mean;

(PM,5) diameter of 2.5 microns  per cubic 25 ug/m3 24-hour mean
or less meter (ug/m®)

Particulate matter (PM)  Particles with a ug/m® 20 pg/m?® annual mean;
diameter of 10 microns 50 pg/m?® 24-hour mean
or less

Nitrogen dioxide (NO,) A main source of nitrate  pg/m° 40 pg/m?® annual mean;
aerosols 200 pg/m3 1-hour mean

Ozone (03) Ozone at ground level ug/m’ 100 pg/m° 8-hour mean

Carbon monoxide (CO) A colorless, odorless ug/m®
and flammable gas

Sulphur dioxide (SO5) A colorless gas with a pg/m’ 20 pg/m?® 24-hour mean;
sharp odor 500 pg/m? 10-minute mean

Number of days exceeding  AQI values at/ below 100 Days/year

AQI standards are generally thought of
as satisfactory

Minimum/maximum daily pg/m°

average concentration

Annual average ug/m’

concentration

3) Input mode for all transport modes

In the input mode for each mode of transport, users only need to enter data into the yellow cells,
which are the key parameters for emission calculation. The white cells in the tabs indicate that they
are input cells and may improve the granularity of the data.

Default values are provided in the self-monitoring tool, however, users must note these values are
placeholders and are subject to high uncertainties. Please also note that the load factors will be fixed
and greyed out when users check the “NA” box. In such case, each of these values is based on a
particular set of assumptions. This may lead to results that over- or underestimate emissions
compared with actual conditions. Figure 5 below illustrates the interface of the road transport tab,
required inputs and corresponding outputs.

% World Health Organization Air Quality Guidelines. (2019). Retrieved from https://www.who.int/news-room/fact-
sheets/detail/ambient-(outdoor)-air-quality-and-health

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0) 6



Figure 5 Interface of “Road transport” tab
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The following functions are common to all transport modes (road, rail and inland waterways). Users
can edit the input data. Click on the yellow/white fields and the parameters can either be edited or
chosen from dropdown lists.

“Calculate”

Calculate the emissions. Users are highly recommended to click on the calculate button once all the
yellow fields are filled out. The tool provides an on-screen report which includes the GHG emissions in
terms of CO, and CO,e. However, users must note that results may not be available and will be greyed
out where critical parameters for emission calculation are not available. Guidance is provided in the
following sections on how to deliver the best output from the information available.

“Insert”

Insert the data. Click on the insert button and the data is stored locally in the excel spreadsheet. Note
that if the parameter exists already in the database, a dialogue box is opened and the users can
choose to update the field.

“Delete”
Delete the data. The data is removed from the tool.

“Show"
Show the data that is stored in the database. Click on the show button and a dialogue window is
opened. Users can select a record and it will be reflected in the corresponding field.

Numerical input and rounding
Decimal notation can be used and it is denoted with a period, e.g., 1.234. Any numerical input is
considered to be a rounded value - rounded to 2 digits.

4) Forecast tab

The “Forecast” tab comprises of “impact assessment” section and “action assessment” section. In
the input mode, users need to enter the data in the yellow fields. The values will be automatically
generated in the orange fields. Figure 6 illustrates the interface of this tab.

A limited set of socio-economic and vehicle technology variables are forecast through to 2050.

Base year refers to the specific year against which a city’s emissions are tracked over time. It
corresponds to the first year filled out in the City profile tab.
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e Growth rate: To forecast road transport emissions, the demand for new road freight activity is

one of the most uncertain variables in the emission reduction analysis. Details on how to
predict can be found in the Forecasting emissions section.

Figure 6 Interface of “Forecast” tab

Impact assessment

Select base year. 2018 Growth rate (%): 3.2* calculate
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Measure Type Description
Change the type of fuel for a specific type of
Fuel technology vehicle. This includes technologies for promoting
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biofuels, bio CNG as well as LNG etc.

Reduce total million kilometres run of an specific
. Distance reduction Avoid type of vehicle. This involves the reduction of VKT
of a specific type of vehicle.

Reduce the fuel consumption improving driving
skill. This involves training drivers to drive in eco-

% Ecdivng JuBEE friendly ways in order to save fuel and reduce
emissions.
Reduce the fuel consumption deliverying during
A off-hours. Also known as “Out of hours”
selec| Off-Hour Deliveries Improve

deliveries, this focuses on shifting freight
deliveries from peak period to off hour period.

Impact assessment
Running the “Impact assessment” involves the following steps:

C02e Million Tonnes

Road transport

2018 2025 2030 2050

m Road transport

1. Load the input data onto the “Impact assessment” section. The base year emissions from

road freight transport are calculated automatically.

2. Using the expected transport growth rate, which is based on additional historical data series,
including GDP, population, among others, the future emissions for 2025, 2030 and 2050 are

projected.

Action assessment

Each of the measures listed in “Forecast” tab have their spreadsheets in the tool. Figure 7 below
depicts the inputs in the “Fuel technology change” assessment. The yellow cells in the scenario

sheets are input cells. For most of the scenarios, several basic parameters are required:

e Base year: It corresponds to the first year filled out in the City profile tab

e Forecast year: by default it is 2050

e Vehicle type: Choose the road freight vehicle type in the dropdown list; the vehicle type and its
respective fuel type should be entered in the road transport before the assessment

e Temperature condition: Whether it is refrigerated or not

e Road freight transport growth rate: It corresponds to the “Freight growth rate (%)” in the

Forecast tab

e Fuel technology used: Choose the fuel type in the dropdown list; the fuel used and its
respective vehicle type should be entered in the road transport tab/ database
e Uplifted values: The current default values for road transport used in the tool are for North

America, Europe and South America. For road freight vehicles in Asia and Africa, uplifted

values are applied to the regional values for Europe and South America.

The following input fields need to be filled out in the scenarios where specific technologies or

strategies that would reduce CO,e emissions are implemented:

e Fuel technology to use: This parameter is required in the “Fuel technology change” tab.
e Distance reduction rate (%): This parameter is required in the “Distance reduction” tab.
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e Eco-driving fuel saving rate (%): This parameter is required in the “Eco-driving” tab.
e  Off-hour periods: This parameter is required in the “Off-hour delivery” tab.

Running the “Action assessment” involves the following steps:

1. Load the above mentioned basic parameters onto the tab. The base year emissions from the
selected vehicle/fuel type are calculated, based on the vehicle activity data entered previously
in the road transport tab/ database.

2. Using the expected freight transport growth rate, the tool forecasts the million km and million
t-km for the year 2050. The CO, e emissions in the Business-as-usual (BAU) scenario are
calculated. BAU scenario describes future emission levels on the assumption that no
additional policies or actions to reduce emissions are adopted.

3. Assuming the million km and million t-km remain the same for the target scenario, the tool
calculates the resulting CO,e emissions using the corresponding fuel emission factors. The
target scenario represents future emissions with the assumption of the introduction of
specific policies and measures targeting GHG emission reductions.

4. The emissions in the target scenarios are then compared to those of the BAU scenario to see
the potential emission reductions.

Figure 7 Interface of “Fuel technology change” tab

Road Transport - Fuel Technology Change Impact Assessment

Forecast year: 2050
Vehicle tvpe:l Light good vehicle (<3.5t) | =
Refrigerated: No

Road freight transport growth rate (%): 3 * «

Fuel type

Fuel technology used: Diesel
Fuel technology to use: Diesel

Uplifted values (Asia, Africa): 0%
Calculate

0.00 0.00 0.00

0.00 0.00 0.00

0.0000 0.0000 0.0000
CO2e emissions reduced (%): 0
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5) Results tab

The "Results" tab contains summary data of the city and its socio-economic data. It also includes a
series of illustrative graphs of the following data:

e Estimated emissions from the road, rail and inland waterways transport for the base year,
expressed as million tons

e Estimated emissions (million tons) and freight transport activities (million ton-kilometer, t-km)
by each mode of transport over the modelled years

e Four types of freight trips, including through, to, from, within. The results are transferred from
the City profile tab.

¢ Share of emissions by vehicle/ train/ vessel type for base year

e Share of emissions by fuel type for each mode of transport

Figure 8 below illustrates the interface of the results tab.
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Figure 8 Interface of “Results” tab
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3. Basic definitions and calculation methods

This section gives an overview of basic definitions, assumptions and calculation methods for freight
transport used in the self-monitoring tool. The focus will be on the standard rules for all transport
modes and the primary differences between them. Detailed data and rules for each mode of transport
are described in the following sections.

Table 3 Transport modes, vehicles, fuel types

Mode of Vehicles, trains, vessels Fuel type
transport

Road Different types of road freight vehicles,  Diesel, gasoline, Liquefied Petroleum
transport aggregated into gross vehicle weight Gas (LPG), Compressed Natural Gas
(GVW), including electric and fuel- (CNG), Liquefied Natural Gas (LNG),
powered freight vehicles Electricity, biomethane and bio LNG
Rail transport Trains of different wagon and operating Diesel and electricity
characteristics for different
commodities
Inland Different types of inland ships, including Marine diesel oil (MDO)
waterways covered cargo, barge, pushed convoy,
transport container, tankers

1) Main factors on emission calculation

The energy consumption and emissions of freight transport depend on a wide array of factors.
Each transport mode has unique properties and conditions. Thus it is important to calculate
emissions separately for each mode.

The following parameters are of general importance for all modes of transport:

e Vehicle/ train/ vessel type, size and weight

e Payload capacity refers to the maximum mass of freight allowed. The determination of
payload is different for different modes of transport. For road transport, the payload of a
vehicle is the difference between maximum vehicle weight and the empty weight of the
vehicle; For trains, special wagon types are used to transport various cargo types (cars,
containers, chemistry etc.), and the payload capacity of a wagon is the difference between the
maximum weight and the empty weight of a wagon.

e Load factor is the ratio of the shipment weight to the payload capacity of a vehicle or vessel.
The amount of CO,e estimated in the tool is sensitive to load factors.
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e Empty running is related to loaded distance allocated to the transport, usually expressed in
distance empty/ total distance.

e Cargo specification (average, bulk and volume goods): Load factors and empty running
factors vary differently for the three categories. Average goods refer to the mixed cargo of
different densities (based on statistics). Bulk goods usually include coal, ore, oil, fertilizer,
while volume goods include industrial parts, consumer goods, such as furniture, clothes.

e Transport distance travelled (kilometers, km)

e Tonne-kilometer (abbreviated as t-km, also written as tonne-km, tonne.km or tkm in table and
formulae), refers to the transport of one ton of goods over a distance of one kilometer. To
evaluate freight transport activities, it is essential to consider both the weight of the shipment
and the distance the cargo is transported. As such, t-km is useful to express efficiency for
freight transport in a consistent manner. Note that for some commodity types, it would be
more appropriate to measure freight movement in terms of volume rather than weight.

e The emission factor of the energy source (including solid and liquid fuels and electricity), i.e.,
the amount of CO,e emitted per unit of fuel used. It is important to be sure about the fuel type
to choose the appropriate fuel emission factor.

e The energy efficiency of the vehicles, trains, or vessels is relevant to the characteristics of the
vehicles, driving behavior, speed, road conditions, topography, and others.

Table 4 below summarizes the parameters that are critical to calculating emissions from all modes of
transport, as well as the mode-specific parameters.

Table 4 Parameter characterization for each mode of transport

Mode of Basic parameters Additional parameters to improve
transport calculation accuracy

All modes - Vehicle/vessel type, size and weight -  Driving conditions: number of stops,
- Payload capacity speed, acceleration etc.
- Capacity utilization (load factor, - Condition: ambient or temperature-
empty trips) controlled
- Cargo type

- Total weight of cargo
- Distance travelled

- tkm
- Emission factors
Road - Road vehicle type, size and weight - Journey type: long haul or multiple
- Payload capacity collections
- Cargo type (average, bulk or volume -  Topography
goods) - Long-distance vs short haul
- Condition: ambient or temperature-
controlled
- Idling time
Rail - Train type, size and weight Topography

- Payload capacity
- Cargo type (primarily cargo density)

- Rail network

Inland - Vessel type, size and weight - Waterway classification

waterway - Payload capacity - Stream direction (up-stream/ down-
- Cargo type (bulk, containers, pallets, stream)

mass-limited cargo and volume-
limited cargo)
- Waterway network
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Which default data is used?

The self-monitoring tool provides default data or setting for calculation. The default emission factors
are sourced from the Global Logistics Emissions Council Framework (GLEC Framework version 2.0)*,
which is based on average freight transport operating practices and provides a general indication of
fuel consumption and emissions. The GLEC Framework is aligned with global efforts on carbon
accounting for logistics operations, including the Intergovernmental Panel on Climate Change (IPCC)
Guidelines for National Greenhouse Gas Inventories, among others. The global warming potential
values are drawn from the IPCC 2007 report.

In general, standard values for load factor and empty running are embedded within the default factors.
However, users should use values that are representative of the specific freight operations in the city,
reflecting the characteristics of their urban freight transport. Table 5 below shows key figures for
empty weight, payload capacity and a maximum weight of different vehicle and vessel types.

Table 5 Empty weight and payload capacity of selected vehicles or vessels

Mode of transport | Vehicle/vessel type Empty Payload Maximum
weight (ton) weight
(ton) (ton)
0.5

Road Non-Motorized rickshaw/Cart - . -
Bicycle/Cargo bike - 0.5 -
Motorized rickshaw /Tuk-tuk - 0.5 -
Motorcycle (2-wheeler) - 0.5 -
Tempo = 0.75 -
Light good vehicle (< 3.5 t) - 1.3 -
Rigid Truck (3.5t-7.51) - 2.3 -
Rigid Truck (7.5t-121) - 5 -
Rigid Truck (12t-20t) - 8.4 -
Rigid Truck (> 20 t) - 15.3 -
Truck and Trailer (> 20 t) - 18.4 -

Rail* Average/mixed wagon 23 61 84
Container wagon 21 65 86
Cars wagon 28 21 59
Chemicals wagon 24 55 79
Coal and steel wagon 26 65 91
Building materials wagon 22 54 76
Manufactured products wagon 23 54 77
Cereals wagon 20 63 83
Truck + trailer on train - 63 =
Trailer only on train - 63 -

Inland waterways** Motor Vessels < 80 m (1000 t) - 477 -
Motor Vessels 85-110 m (1000-2000t) - 1497 -
Motor Vessels 135 m (2000 - 3000 t) - 2135 -
Coupled convoys 163 - 185 m = 2903 =
Pushed convoy - push boat + 2 barges = 3000 =
Pushed convoy - push boat + 4/5 barges - 8000 =
Pushed convoy - push boat + 6 barges = 10000 =
Tanker vessels = 4195 =
Container vessels 110 m = 1410 =
Container vessels 135 m = 3141 =
Container vessels - Coupled convoys - 2502 -

* Smart Freight Centre. Global Logistics Emissions Council Framework for Logistics Emissions accounting and
Reporting. (2019). Retrieved from https://www.smartfreightcentre.org/en/how-to-implement-items/what-is-glec-
framework/58/
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Sources: GLEC Framework (version 2.0).

IFEU, INFRAS & IVE. Ecological Transport Information Tool for Worldwide Transports: Methodology and
Data Update 2018. (EcoTransIT)".

Smart Freight Centre & STC-NESTRA. GHG Emissions Factors for Inland Waterways Transport. (2018).
*For rail transport, the empty weight refers to the empty weight of wagon. They are average values from
transport statistics.

** For inland waterway transport, the payload is based on weighted averages.

2) General calculation approaches

The calculation methodology behind the self-monitoring tool is consistent and is mainly based on the
GPC and GLEC Framework. Generally, the methodologies for estimating transport emissions can be
categorized as fuel-based and activity-based approaches.

Fuel-based approach

The fuel-based approach uses the fuel consumption data and converts fuel use into GHG emissions
with defined emission factors. This method calculates emissions based on the amount of fuel sold
within the city boundary. The data on the amount of fuel sold can be obtained from fuel dispensaries
or fuel sales tax receipts.

Different types of fuel emit different amounts of carbon. Thus, it is important to calculate item by item
for each fuel type separately. The emission factors for biofuel and hydrogen fuel cells are not
included in the guidance, as there is a lack of widely-accepted value for the WTT emissions.

This approach uses the following equation:
Equation 1 Fuel-based approach for emission calculation

CO, emissions =
Y (quantity of fuel consumed (liters) x emission factor for the fuel (e.g., kg CO.e/liter)
+

sum across grid regions:
> (quantity of electricity consumed (kWh) x emission factor for electricity grid (e.g., kg CO,e/kWh))

Description Value
Total CO,e emissions in tons Computed
Quantity of fuel consumed in liters, gallons or kilograms User input

Emission factor for the fuel (e.g., kg COe/liter, or kg CO,e/gallon, or Default data
kg CO.e/kg)

Emission factor for electricity grid (e.g., kg CO,e/kWh) Default data

Source: GPC

If fuel data is not available, users may calculate the quantities of fuel consumed from fuel spend or
from the distance travelled.

® IFEU, INFRAS & IVE. Ecological Transport Information Tool for Worldwide Transports: Methodology and Data
Update 2018. (2018). Retrieved from
https://www.ecotransit.org/download/EcoTransIT_World_Methodology_ShortVersion_2018.pdf
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Box 2 Additional information on emission factors

Fuel emission factors are used for converting the amount of fuel used into the GHG emissions, e.g. kg
CO,e emitted per liter of fuel consumed. They are different for different types of fuel and they may vary
from country to country for the same type of fuel as different type of blends may be applied. For instance,
it is common to blend relatively low percentages (5—10 percent) of biofuels into conventional fuels, which
means the generalization of emission factors could lead to greater uncertainties. The GLEC Framework
provides representative fuel emission factors (see Annex 1) based on global averages; however actual
emission factors may vary depending on the specification of the fuel.

Electricity emission factors are used to convert electricity consumption to emissions based on the
sources of energy used to create electricity. They are often expressed as mass of CO,e released for the
kilowatt hours (kWh) of electricity used. While there is a greater focus on electrification as a central
element to improve air quality and decarbonize the transport sector, the electricity emission factors in
some countries are changing rapidly, also facilitated by the growing investment in renewable energy
technologies. The International Energy Agency (IEA) publishes lists of national electricity emission factors
on an annual basis, which are available for purchase from its website.

Source: GLEC Framework (Version 2.0)

Activity-based approach

If access to fuel consumption data is limited or incomplete, a calculation using the activity-based
approach may be recommended. This approach seeks to quantify emissions within the city, including
the trips that begin, end, or within the city. This requires information on vehicle kilometers travelled
(VKT) for each vehicle type, vehicle occupancy, information on vehicle fuel efficiency or emission
intensity factors, which are applied in multiple steps. The component variables can be disaggregated.
The approach uses the equation as follows:

Equation 2 Activity-based approach for emission calculation

Sum across transport modes and/or vehicle types:

Y (mass of goods transported (tons)

x distance travelled (kilometers)

x emission factor of transport mode or vehicle type (e.g., kg CO,e/tonne-kilometer)

Description Value

Total CO,e emissions in tons Computed

Mass of goods transported in tons Default data provided in
Annex 1

Distance travelled in kilometers User input

Emission intensity factor in kg CO,e/t-km Default data

Emission factor for electricity grid = Electricity emission factor(e.g., Default data
kg CO,e/kWh)

Source: GPC

The main variables required to calculate emissions from freight transport are presented in Figure 9.
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Figure 9 The calculation approach for freight transport emission
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Cities should decide which approach to use based on the availability and quality of data and how the
data will be used. For instance, the fuel-based approach can be more accurate to show the emissions
from the freight transport sector, while the activity-based approach can give detailed information
transport activities and help prioritize actions. See Annex 2 Comparing fuel-based and activity-based
approaches for a comparison of both approaches.

Changing the calculation approach over time

Cities may be able to collect more accurate and reliable data over time, using new data collection
methods and new technologies. As such, cities may update the input data or switch the calculation
approach and should clearly indicate the approach used and the data sources.

4. Methodology and data for each transport mode

This section includes the methodology for the calculation of energy consumption and emissions of
freight transport as well as the data sources used for each mode of transport in detail.

1) Road transport

On-road transport contributes significantly to the global transport emissions. Freight transport by road
is expected to grow. Currently, the vast majority of road freight vehicles burn liquid or gaseous fuel in
internal combustion engines, which produces CO,, CH, and N0, often referred to as tailpipe
emissions. Increasingly, electrification of short-distance freight vehicles is becoming a viable option.

On-road freight vehicles are designed to transport goods on public roads or highways. This category
includes vehicles such as motorcycles, trucks, and waste collection vehicles. Emissions from road
transport refer to the fuel or electricity used to operate road freight vehicles, and exclude the
emissions related to the production of vehicles or road infrastructure.
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Vehicle type characteristics and load factors

To calculate the fuel consumption and road emissions, it is essential to differentiate the types of
vehicles and gather information on how heavy the vehicles are loaded. Default values are given for
load factors and capacity utilization, which should be replaced by specific operational data for more
accurate calculation.

Table 6 illustrates the applicable vehicle sizes, weights and default load factors in the tool.

Table 6 Classification on-road vehicles

Type of road vehicles Payload Load factor Empty running (%)
(ton) @ (%)

Non-motorized rickshaw/cart

Bicycle/cargo bike 0.5 - =
Motorized rickshaw/tuk tuk 0.5 = =
Motorcycle (Two-wheeler) 0.5 - -

Tempo 0.75 = =

Light good vehicle (< 3.5 1) 1.3 In the range of 24% and 36%*
Rigid truck (3.5t-7.51) 2.3 60% 17%

Rigid truck (7.5t-121) 5 60% 17%

Rigid truck (121-201) 8.4 60% 17%

Rigid truck (> 20 1) 15.3 60% 17%
Truck and trailer (> 20 t) 18.4 60% 17%

*LGVs running on petrol have a combined load factor & empty running of 24 percent; when fueled by
other types of energy sources, e.g., diesel, CNG, LPG, a standard value of 36 percent for load factor and
empty running is embedded within the default factors.

Source: GLEC Framework

Parameters for emission calculation

Table 7 below shows the requirements for the estimation of road transport emissions.

Table 7 Parameters for road transport emission calculation

| Parameter | Descripton ________________________________JUnit

Year of assessment Select the modelled year, e.g., 2019; Base year
corresponds to the first year filled out in City profile tab
Gross vehicle weight Select the type of vehicle Ton (1)
(GVW)
Load factor Load factors make a significant impact on energy use and  Percentage (%)

emissions. Standard values for empty running and load
factors are embedded within the default emission
intensity factors for different types of vehicles (See Annex
1).
Total distance Actual distance should be inputted if available. In general,  Million km
only vehicle operators have access to actual distance
travelled. Cities can seek carriers and logistics companies
for the activity data; when a sampling survey is used,
cities can scale up the activity data to the city-scale.

Ton-kilometer The tool uses the following equation: Million t-km
(t-km) t-km = Payload capacity (t) x Load factor (%) x Total

distance (km)
Fuel type The calculation depends on the fuel type. Most on-road

freight vehicles burn diesel or gasoline, while other
potential types include electricity, CNG, LNG, LPG,
biomethane, and bio LNG.

Unit Fuel use is usually reported using mass (kg) as the unit; In
practice, liquid fuels are measured by volume (liters or
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gallons). In the dropdown-list, users can select the
preferred unit to specify fuel consumption. The data can
be provided in the following units:

Diesel: kg, liters, gallons

Gasoline: kg, liters, gallons

LPG: kg, liters, gallons

CNG: kg

LNG: kg

Electricity: kilowatt-hours (kWh)

Biomethane: kg

Bio LNG: kg

Fuel consumption Fuel consumption figures, expressed as liters per 100 Liter/100km,
kilometers (L/100 km), refer to the amount of fuel the gallon/100km,
vehicle needs to travel a certain distance. In general, the kg/100km or
lower the value, the more economic a vehicle is. Fleet- kWh/100km,
wide fuel consumption rates depend on an array of depending on
factors: freight vehicle mix, fuel mix of freight vehicle the fuel type,
stock, vehicle age, distance travelled, average speed and but this is
congestion level etc. They can typically be derived by automatically
dividing total fuel use by total kilometers. selected.

Electricity EF When users select electricity as the energy type, additional

information about emission intensity of electricity
generation (g CO2e/kWh) is required. In the dropdown list,
the following values are provided:

¢ Inregions where coal-based electricity generation
is commonplace: 850 g CO,e/kWh

e Fossil-based: 500 g CO,e/kWh

e Average EU: 320 g CO,e/kWh

e On the way to renewable energy: 200 g CO,e/kWh

e Largely decarbonized: 30 g CO,e/kWh

e Not applicable: A dialogue box is presented,
asking users to select the energy source for its
electricity generation.

e Others*: A default value of 160 g CO2e/kWh is
provided, however it must be noted that the value
is only a placeholder and users need to enter the
value in the “Electricity EF” hidden worksheet. To
unhide the worksheet, you can follow the steps:
On the Home tab, in the Cells group, click
Format > Visibility > Hide & Unhide > Unhide
Sheet. You'll be presented with a dialog box listing
the sheets that are hidden, so select the
“Electricity EF” and enter the value there.

*While some countries publish their own electricity
emission factors®, there is no guarantee that they are
calculated on the same basis. Therefore the emissions
per kWh should be used with caution and the databases
should be updated regularly. For users who have little
knowledge of their national electricity emission factors,
the figures above are a suitable starting point.

It should also be noted that the values are only applicable

® Available sources can be found here:
https://www.carbonfootprint.com/docs/2019_06_emissions_factors_sources_for_2019_electricity.pdf
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to vans (up to 3.5 1), rigid trucks (3.5t- 7.5 t GVW) and
rigid trucks (7.5 t- 12 t GVW), as well as rail transport
where the locomotive uses electricity as its energy source.

Type of trip flow Select between within, through, to, from
(optional)

Type of goods Select between average, bulk and volume goods
(optional)

Refrigerated (optional) Temperature controlled or not, when users choose
“refrigerated”, for vans (up to 3.5t GVW), a 15% uplift will
be applied to the values presented in Annex 1 Default
emission factors; For heavier vehicles (> 3.5t GVW) a 12%
uplift will be applied.

Number of vehicles Many vehicle registration databases do not deregister Thousand (k)
(optional) vehicles that are scrapped or out of service. This might
give higher emission factors to the calculation.
Age of vehicles Select between 0 — 5,5 - 10, 10 — 15, Over 15 or Not
(optional) applicable.

2) Rail transport

It is estimated that approximately 7 percent of global freight transport activity (in terms of tonnekm)
were shipped by rail in 2015, which contributed to 4 percent of the GHG emissions from the
transportation sector’.

Railways are powered by locomotives, which typically use energy through the combustion of diesel or
electricity. Previous studies indicate that CO, emissions per t-km are significantly lower for electric
traction.

Emissions from rail transport include the energy used to move cargo under its power or hauled by
another vehicle. Similar to road transport, the most accurate way to calculate emissions from rail
transport is to use direct measurements of fuel consumed. Cities should obtain fuel consumption
data from the railway operators by fuel types when available.

Train type and load factors

The tool takes into account different train types, defined by the gross ton weight of the train and the
cargo types.

Table 8 Train type, payload and load factors

Train Type Payload Load Empty

capacity factor running

wagon (%) (%)

(ton)
Average/mixed 1000 23 61 60% 33% 84
Container 1000 21 65 50% 17% 86
Cars 700 28 21 85% 33% 59
Chemicals 1200 24 55 100% 50% 79
Coal & steel 1700 26 65 100% 50% 91
Building materials 1200 22 54 100% 50% 76
Manufactured products 1200 23 54 75% 38% 77
Cereals 1300 20 63 100% 38% 83

’ International Energy Agency & International Union of Railways. Railway Handbook 2017: Energy Consumption
and CO, Emissions. (2017). Retrieved from https://uic.org/IMG/pdf/handbook_iea-uic_2017_web3.pdf
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Truck + trailer on train = = 63 85% 33% >
Trailer only on train = 63 85% 33% >
Source: GLEC Framework (Version 2.0) and EcoTransIT World Methodology and Data Update 2018.

Parameters for emission calculation

For the self-monitoring tool, it is desirable to include all the parameters with the most notable impact
on the end results, while taking into account the availability of data for these parameters.

The parameters affecting rail transport emission calculation is listed in Table 9 below. The estimate
should be based on actual operating data, if not publicly available datasets.

Table 9 Parameters for rail transport emission calculation

| Parameter | Descripton _____________________________[Unt

Year Select the year for assessment in the dropdown-list

Train type Train types can be divided into general cargo types (average, bulk
and volume goods) and dedicated cargo types (container, cars,
chemistry etc.).

Load factor For rail transport, there is no well-established load factor. Existing  Percentage (%)
tools estimate the load factor based on net and gross ton-
kilometers for the above-mentioned cargo types.
Total distance The actual rail network distance should be used in the calculation. km
In practice, rail distance can be hard to find, but some existing
tools can be useful, for instance, EcoTransIT’s online tool®.
t-km Similar to other transport modes, t-km is the key unit for rail Million t-km
transport, representing one ton of cargo moving for one kilometer.
Actual or estimated shipment weight based on the mass of cargo
should be used to calculate t-km, if available.

Type of Diesel and electricity are the most common fuel types for rail Liters or
traction transport. Cities should obtain fuel consumption data from railway gallons for
operators by fuel type. Where detailed activity data are diesel, Kwh for

unavailable, cities can use queries or surveys to calculate the fuel  electricity
use and amount of goods transported, scale down regional or
national fuel consumption based on city population or other

indicators.
Fuel Depending on the fuel type, fuel consumption estimates for rail Liters/100km,
consumption freight vary widely. gallons/100km

or kWh/100km
Electricity EF Similar to the road transport tab, when the locomotive uses
electricity as its energy source, additional information about
emission intensity of electricity generation is required,
Please refer to Table 7 for data input requirements and Box 2 for
more information about emission factors.

Number of The tool assumes a default number of wagons (20) when using
wagons the activity-based approach.
(optional)

3) Inland waterways transport

Freight transport by inland waterways transport comprises a relatively small share of the urban freight
sector.

® See more https://www.ecotransit.org/calculation.en.html
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Water transportation includes ships, ferries and boats operating within the city boundary. The
emissions from inland waterways refer to the movement of cargo along stretches of water.

Representative vessel types and load factors

A wide range of vessel sizes and cargo types can be distinguished. The GLEC Framework suggests
using the following vessel classes for Europe.

Table 10 Vessel types and payload

Vessel type Payload Combined load factor
(ton) & Empty running (%)

Motor Vessels < 80 m (1000 t) 477 55%
Motor Vessels 85-110 m (1000 - 2000 t) 1497 52%
Motor Vessels 135 m (2000 - 3000 t) 2135 50%
Coupled convoys 163 -185m 2903 61%
Pushed convoy - push boat + 2 barges 3000 70%
Pushed convoy - push boat + 4/5 barges 8000 70%
Pushed convoy - push boat + 6 barges 10000 70%
Tanker vessels 4195 65%
Container vessels 110 m 1410 75%
Container vessels 135 m 3141 75%
Container vessels - Coupled convoys 2502 68%

Source: GLEC Framework (Version 2.0) and Smart Freight Centre & STC-NESTRA. GHG Emissions
Factors for Inland Waterways Transport. (2018).

Parameters for emission calculation
The parameters affecting inland waterway transport emission calculations are summarized below.

Table 11 Calculation parameters for inland waterway transport emission

| Parameter | Descripton _______________________________JUnit

Year Choose the year for assessment in the dropdown-list

Vessel type Select type of vessel. The tool suggests using the above-
mentioned vessel classes (incl. typical payload of a
representative vessel belonging to that vessel class), however,
it is acknowledged that a wide range of vessel types and sizes
can be distinguished depending on the country and region,
e.g., in the US and South America the preferred vessels used
for inland navigation are largely pushed convoys.

Load factor Average load factors for the above-mentioned vessel types Percentage (%)
are used; Generally, it is in the range of 45 - 75 percent,
depending on vessel types.

If the load factor is known to be different from the
representatives incorporated in the default values, cities
should work to obtain a fuel efficiency value that reflects the
actual conditions.

Total distance Actual waterway network distance should be used, based on km
the origin and destination of the freight trip. For instance, data
from the vessel log book.

t-km A consistent approach to calculating weight, distance and t-
km is required to streamline data sharing and improve the
accuracy of results.

Actual shipment weight should be used, if available. Cities can
obtain data using official records of surveys to determine the
weight of cargo.

Fuel type Marine diesel fuel is the assumed fuel type for inland water
transport. Cities can seek this data from shipping companies
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and fuel suppliers.

Fuel Provide information on the fuel consumption in terms of Liters/100km or
consumption liters/ 100km or gallons/ 100km. gallons/100km
Type of trip flow  Specify the type of freight trip
(optional)
Type of goods Specify cargo type that is transported by representative
(optional) vessel: Bulk/ Containers/ Pallets/ Mass-limited/ Volume-
limited, when unknown, choose not applicable
Number of Specify the number of vessels per vessel class registered in Thousand (k)
vessels the city
(optional)
Age of vessels
(optional)

5. Forecasting emissions

In the self-monitoring tool, collected data can be used to determine current emissions. Analysis can
also be used to project future emissions under circumstances that may happen without intervention,
which is often called business-as-usual (BAU). The measurement of current freight movement data
serves as the basis for the BAU calculation, which must then be projected into the future for ex-ante
analysis or ex-post analysis.

Besides, the tool estimates target scenarios where specific policies or strategies are hypothetically
implemented by the city. The target scenario considers additional measures which allow the freight
transport sector to deviate from the BAU emission trajectory.

Figure 10 depicts how emission reductions are calculated for each of the scenarios.

Figure 10 Estimation of potential emission reductions

A

Potential
emission
reductions

Business- Target
as-usual scenario
(BAU) emissions
scenario
emissions

GHG emissions ( Mt COy)

v

In broad terms, opportunities to reduce GHG

Year emissions from freight transport can be divided

into the following categories:

- Avoid (and reduce) the freight volume and haul distance
- Shift (and maintain) to more sustainable modes of freight transportation
- Improve the logistics operations by use of technologies and better operation
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The target scenario considers different measures in isolation as determined based on local
development priorities, feasibility, costs and benefits assessment.

Table 12 below depicts a balanced combination of “Avoid-Shift-Improve” strategies that are
applicable for urban freight movement.

Table 12 Selected measures for impact assessment

| Measure | Type | Brief description

Fuel technology Improve This includes new technologies that promote high efficiency and
change alternative fuels, such as biofuels, bio CNG, LNG.

Distance Avoid This involves the reduction of VKT of a specific type of vehicle.
reduction

Eco-driving Improve This encourages behavioral change amongst drivers to drive in eco-

friendly ways to save fuel and reduce emissions.
Off-hour deliveries Improve Also known as “Out-of-hours” deliveries, this focuses on shifting
(OHD) freight deliveries from peak period to off-hour period.

It is important to estimate freight transport growth rate for emission reduction forecasting. There are
several general approaches for projecting the amount of freight activity:

1. Use the global freight demand growth rate based on economic projections: It is well
established that demand for freight transport is primarily driven by trade and economic
growth.

2. Use national or regional freight demand models based on commodity flows: Some national
or state level government agencies prepare a commodity-based freight model, as part of a
larger travel demand forecasting model.

3. Expert judgment based on historic trends

In order to provide indicative estimates to fill data gaps, insights from existing global and regional
studies on freight transport are used in the tool to estimate the road freight transport growth rate.
Latest estimate from the International Transport Forum (ITF) suggests that the global freight
transport demand grows at 3.1 percent and 3.4 percent annually through 2030 and 2050 respectively
(ITF Transport Outlook 2019°%). However, the accuracy of growth projections is uncertain, in light of
the current instability of the global economy. It must be noted that it can be misleading to rely on
global data, and good quality in-country data should be sought whenever possible.

1) Fuel technology change

Fuel technology change refers to adopting technologies that promote high efficiency and alternative
fuels, such as biofuels, CNG, LNG. These actions are intended to cut overall GHG emissions by
reducing the use of carbon-intensive fuels. The reduced carbon intensity of the new fuels can be from
reduced upstream emissions. The required input data is listed as follows:

Table 13 Parameters for fuel technology change projection

| Parameter | Descripton ___________________________|Unit

Base year The base year corresponds to the first year filled out in the City profile
tab

Forecast year By default the forecast year is 2050

Vehicle type Select vehicle type. It should be noted that the vehicle type and its fuel

type should be entered in the road transport tab/ database before the
impact assessment.
Refrigerated Specify whether the vehicle is refrigerated or not
Road freight The rate corresponds to the growth rate filled out in the forecast tab. A Percent

° OECD/ITF (Organization for Economic Co-operation and International Transport Forum). ITF Transport Outlook

2019. (2019). Retrieved from https://www.oecd-ilibrary.org/transport/itf-transport-outlook-2019_transp_outlook-
en-2019-en
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transport default value of 3 percent is provided in the tool, using the estimated age (%)
growth rate global freight demand growth rate. However, it must be noted that the
value is only a placeholder and may not reflect actual conditions. It is
recommended that users apply more locally-suited numbers, if available.

Fuel Current fuel type, which serves as the basis for the base year’'s emission

technology calculation. Similar to the vehicle type input field above, the fuel type

used should be entered in the road transport tab/ database before the impact
assessment.

A default corresponding emission intensity factor is provided based on
the vehicle type and fuel type. See Annex 1 for more details. When users
select electricity as the energy type, an additional input is required, i.e.
electricity emission factors.

Please refer to Table 7 for data input requirements and Box 2 for more
information about electricity emission factors.

Fuel Forecast change in fuel type. Same as above, a default value of
technology to emission intensity factor is automatically selected, if applicable.
use It should be noted that in the following scenarios, a dialogue window is

opened, indicating that the calculation for selected option is not
available and the results are unlikely to be accurate:

LGV (< 3.5 t): Switching from diesel to gasoline

Rigid truck (12 - 20 t): Switching from diesel to LNG
Rigid truck (> 20 t): Switching from diesel to LNG
Truck and trailer (> 20 t): Switching from diesel to LNG

See

Box 3 below for more information.
Uplift value to In line with the GLEC Framework, the tool recommends the emission Percent
use in Asiaand intensity values for road vehicles (European and South American values) age (%)
Africa as a starting point. In Asia and Africa an uplifted value of 13% should be

applied for light goods vehicles (< 3.5 t) and an uplifted value of 22%
should be applied for heavier vehicles (> 3.5 1).

To calculate the GHG emissions in the target scenario, the tool assumes the million km and million t-
km remain the same as those in the BAU scenario. Broadly speaking, each scenario discussed below
is based on a particular set of assumptions and the results are unlikely to be highly accurate. However,
it may be considered as a suitable starting point where there is limited access to data or little detailed
knowledge.
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Box 3 Special considerations for LNG

In the fuel technology change assessment, the GHG emissions seem to increase for heavier trucks (>
12 t) switching from diesel to LNG. It is acknowledged that the emission factors for LNG as a road
transport fuel are still evolving and have higher uncertainty than for established fuels such as diesel.
Nonetheless, there is a growing consensus that on a full GHG impact basis, fossil LNG is not yielding
the benefits claimed by fuel and truck suppliers.

Some studies suggest that the use of trucks running on LNG instead of diesel is not a suitable
measure for climate protection in road freight transport. Although LNG trucks have lower tailpipe CO,
emissions, they emit other types of GHGs elsewhere. In particular, the operation of the vehicles leads
to considerable methane emissions. When taking into account non-CO, GHG emissions, spark
ignition natural gas engine (SI-NG) trucks have approximately the same WTW GHG emissions as
diesel trucks (-2 % to +1 %).

Source: Private communication from Alan Lewis; Ol - Oeko-Institut e.V. (2020): Mottschall, M.; Kasten,
P.; ICCT - International Council on Clean Transportation (2020): Rodriguez, F. Decarbonization of on-
road freight transport and the role of LNG from a German perspective.

2) Distance reduction

To calculate the impact of distance reduction on GHG emissions, we assume the fuel type used
remains the same but million km and million t-km are reduced according to the parameter “Distance
reduction (%)”. Other parameters are the same as those in Table 13.

3) Eco-driving

Eco-driving is based on a series of techniques that drivers can adapt to reduce fuel consumption and
GHG emissions. This includes reducing the use of air conditioning, minimizing engine idling,
maintaining steady speed, avoiding sharp acceleration and braking. Additional non-behavioral
measures include regular vehicle maintenance.

The input parameters are similar to those in Table 13. For the parameter “Eco-driving fuel saving rate”,
we assume an average value of 10 percent based on existing studies. However, the extent to which
drivers commit to eco-driving behavior is a major uncertainty factor. The results are highly variable in
terms of context: vehicle type, road type, traffic flow and so on'’. Table 14 describes the fuel savings
from eco-driving program.

In this tool, fuel savings are assumed to be equivalent to emission savings, which is commonly used
by other studies looking at CO, effects. While this would be true in percentage terms, the absolute
emission reduction from fuel saving would vary according to the fuel being used. Assuming km and t-
km remain the same values in the BAU scenario, the resulting emissions are calculated by multiplying
the BAU emissions with (1 - Eco-driving fuel saving rate).

Table 14 Fuel savings from eco-driving

Urban networks Fuel saving
rate (%)

Mixed roads Average 10%  Only limited benefits for HGVs as driving dynamics are
constrained by the traffic volume and road layout

Junctions, traffic lights,  Up to 25% Eco-driving can save up to 25% of CO, for HGVs in very

bends localised situations

Congested situations 0% Little or no CO, benefit

1% Recent study on freight transport operations in Colombia show that after the eco-driving campaign, an average
reduction of 6.8 percent is obtained when fuel consumption is measured in terms of liters per ton-100 km.
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and motorways

Source: “ITS4CV” - ITS for Commercial Vehicles. Study of the scope of Intelligent Transport Systems
for reducing CO2 emissions and increasing safety of heavy goods vehicles, buses and coaches. (20176).
Retrieved from http://erticonetwork.com/wp-content/uploads/2016/09/ITS4CV-Report-final-2016-09-
09.pdf

4) Off-hour deliveries

Off-hour deliveries (OHD) focus on shifting freight deliveries from peak period to off hour period to
improve safety and reduce congestion and emissions

A large body of research on OHD assessed the environmental impacts and the potential emission
reductions attributable to the implementation of OHD program. The magnitude of the emission
reductions depends on the extent of the change of delivery time. Table 15 below indicates that OHD
reduces emission by 13 to 56 percent compared to deliveries during regular hours in similar routes.

Table 15 Emission reductions from off-hour deliveries

Off-hour periods Emission reduction rate (%)

19.00 - 6.00 Late night and early morning Average 56% (45% - 67%)
periods (Full OHD)

18.00 - 22.00 Partial off-hour (Partial OHD) Average 13%

6.00 - 19.00 Regular hours 0%

Source: Holguin-Veras, José & Encarnacion, Trilce & Gonzalez-Calderon, Carlos & Winebrake, James &
Wang, Cara & Kyle, Sofia & Herazo-Padilla, Nilson & Kalahasthi, Lokesh & Adarme, Wilson & Cantillo,
Victor & Yoshizaki, Hugo & Garrido, Rodrigo. (2016). Direct impacts of off-hour deliveries on urban
freight emissions. Transportation Research Part D: Transport and Environment.
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Annex 1 Default emission factors

1) Fuel emission factors

Fuel emission factors are critical in the calculation of emissions from freight transport. Table 16
below shows CO, and CO,e emissions for the WTT, TTW and WTW phases. Values are presented by
volume and mass, where appropriate. The following values are derived from GLEC Framework
(version 2.0), which itself draws heavily on other credible sources including the European standard
EN16258/JEC"", IATA RP1678'%/ICAO, Clean Cargo Working Group (CCWG) and Handbook of
Emission Factors (HBEFA) etc.

You can find these values in the hidden worksheet of “fuel emission factors” in the Tool. To unhide
the sheet, you can go to the home tab, click Format > Visibility > Hide & Unhide > Unhide Sheet.

Table 16 Fuel emission factors

Fuel type kg CO,/kg kg CO,e/kg fuel | kg CO,/I kg CO,e/I
fuel WTW CO.e fuel fuel
WTW CO, WTW CO, WTW CO.e

Bio LNG kg N/A 1.04 N/A N/A
Biomethane kg N/A 0.49 N/A N/A
CNG kg N/A 3.07 N/A N/A
Diesel Liters 3.86 3.90 3.21 3.24
Diesel** Gallons N/A N/A 0.85 0.86
Gasoline Liters 3.78 3.86 2.82 2.88
Gasoline** Gallons N/A N/A 0.75 0.76
Heavy fuel oil (HFO)* Liters 3.38 3.41 3.28 3.31
HFO* Gallons N/A N/A 0.87 0.88
LNG kg N/A 3.62 N/A N/A
LPG Liters 3.43 3.46 1.89 1.90
LPG** Gallons N/A N/A 0.50 0.50
Marine diesel oil Liters

(MDO) 3.89 3.92 3.50 3.53
MDO** Gallons N/A N/A 0.93 0.93

Sources: GLEC Framework (Version 2.0).

* CO,e has been derived from CO, according to a scaling factor; See GLEC Framework (Version 2.0)
Module 1 for examples of uplift scaling values from TTW to WTW.

** The emission factors have been converted from kg CO2 /I fuel to kg CO2/gallon fuel using the
equation: 1 Liter (I) = 1 US Gallon X 3.78.

2) Road transport emission intensity factors

Emission intensity factors are often expressed as GHG emissions per t-km. The tool uses
representative values of emission intensities recommended by GLEC Framework. The main datasets
are primarily based on North America and Europe and provide generic information, thus may not be
accurate in reflecting the actual conditions in each city.

Table 17 Road transport emission intensity factors (Fuel)
Type of road Load Empty WTW WTW emission Uplift
vehicles factor | running emission intensity values in

(Vehicle size) | (%) (%) intensity (g CO,e/t-km) Asia and
(g CO,e/t- (Refrigerated)* Africa

M European Committee for Standardization. EN 16258: Methodology for calculation and declaration of energy
consumption and 16258GHG emissions of transport services (freight and passengers). (2012).
"2 |nternational Air Transport Association. Recommended Practice 1678. (2014).
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km) (%)**
(Amblent)

Light goods 36%*** Diesel, 5% 13%
vehicle biodiesel
(<3.51) blend (B5)
24%*** Petrol 1000 1150 13%
36%*** CNG 620 710 13%
36%*** LPG 660 760 13%
Rigid truck 60% 17% Diesel, B5 370 415 22%
(3.5t-7.51) CNG 360 405 22%
Rigid truck 60% 17% Diesel, B5 240 270 22%
(7.5t-12%) CNG 220 250 22%
Rigid truck 60% 17% Diesel, B5 150 170 22%
(12t-201) CNG 150 170 22%
LNG 180 200 22%
Rigid truck 60% 17% Diesel, B5 120 145 22%
(>201) CNG 120 145 22%
LNG 140 170 22%
Truck and 60% 17% Diesel, B5 90 100 22%
trailer (> 20 t) CNG 90 100 22%
LNG 90 100 22%

Source: GLEC Framework (Version 2.0)

*Refrigerated freight vehicles: apply a 15% uplift to the values for vans (up to 3.5t); Apply a 12% uplift
for heavier vehicles (> 3.5 ).

**In Asia and Africa, apply a13% uplift to the values for vans (up to 3.5 t); Apply a 22% uplift for heavier
vehicles (> 3.5 ).

***+ Combined load factor and empty running

Table 18 Road transport emission intensity factors (Electricity)

Type of road vehicles (Vehicle Load factor (%) Empty running (%) WTW emission
size) intensity
(kWh/t-km) (Ambient)

Light goods vehicle Combined load factor & empty running: 1.1
(<3.51) 31%

Rigid truck (3.5t-7.51) 60% 17% 0.5
Rigid truck (7.5t-121) 60% 17% 0.4

Source: GLEC Framework (Version 2.0) and International Energy Agency (IEA).

*Refrigerated freight vehicles: apply a 15% uplift to the values for vans (up to 3.5 t); Apply a 12% uplift
for heavier vehicles (> 3.5 t).

**In India, apply a13% uplift to the values for vans (up to 3.5 t); Apply a 22% uplift for heavier vehicles (>
3.51).

For cities where only limited data are available, GLEC Framework recommends the following WTW
emission intensity values for road vehicles (in Europe and South America) as a starting point.
However it must be noted that these values are based on a set of high-level assumptions thus the
results are unlikely to be accurate.

Light Goods Vehicle (<3.5 t): 680 g CO,e/t-km (WTW)
Urban truck (3.5-7.5): 370 g CO.e/t-km (WTW)

Medium Goods Vehicle (7.5 - 20 t): 200 g CO,e/t-km (WTW)
Heavy Good Vehicle (>20 t): 92 g CO,e/t-km (WTW)

3) Rail transport emission intensity factors

Table 19 Rail diesel traction emission intensity factors

Train Type Payload [ Load factor (%) | Empty running
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(ton) (%) (g CO2e/t-km)
WTW

Average/mixed 60% 33%

Container 65 50% 17% 25
Cars 21 85% 33% 60
Chemicals 55 100% 50% 24
Coal and steel 65 100% 50% 19
Building materials 54 100% 50% 23
Manufactured products 54 75% 38% 24
Cereals 63 100% 38% 18
Truck + trailer on train 63 85% 33% 130
Trailer only on train 63 85% 33% 90

Source: GLEC Framework (Version 2.0)

If the train is powered by electricity, users should choose the appropriate electricity emission factors
and electricity grid factor.

Table 20 Rail electricity traction emission intensity factors

Train Type Payload | Load factor (%) Empty running Consumption factor
(ton) (%) (kWh/t-km) *

Average/mixed 60% 33% 0.0322
Container 65 50% 17% 0.0294
Cars 21 85% 33% 0.0693
Chemistry 55 100% 50% 0.0277
Coal and steel 65 100% 50% 0.0215
Building materials 54 100% 50% 0.0268
Manufactured products 54 75% 38% 0.0282
Cereals 63 100% 38% 0.0212
Truck + trailer on train 63 85% 33% N/A

Trailer only on train 63 85% 33% N/A

Source: GLEC Framework (Version 2.0) and EcoTransIT World Methodology and Data Update 2018.

The Indian railways currently transport the following cargo types: coal, iron and steel, cement and
food grains. By taking into account India’s specific conditions, national electricity grid and power
generation sources, the following emission intensity factors are recommended to calculate the
emissions for Indian railway freight movement.

Box 4 Rail transport emission intensity factors in India

CO, emissions per net-ton-km for diesel locomotive = 0.00951 kg
CO, emissions per net-ton-km for electric locomotive = 0.01146 kg
CO, emissions per net-ton-km for mixed goods train = 0.01072 kg

Sources: India GHG Program, India Specific Rail Transport Emission Factors for Passenger Travel and
Material Transport. (2015).

Eswara AK. Carbon emissions from Indian Railways — An estimation for transportation of goods during
2010-2011. (2012).

4) Inland waterway transport emission intensity factors

The following factors are recommended by the GLEC Framework as the representative values. The
datasets are primarily based on European water transport operations and may not reflect the actual
conditions in other continents. If applicable, cities should seek to obtain in-country data.
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Table 21 Inland waterway transport emission intensity factors

Type of vessels Payload | Combined load Emission intensity
(ton) factor & empty (g CO,e/tkm)
running (%) WTW

Motor Vessels < 80 m (1000 t) 55% 30
Motor Vessels 85-110 m (1000 - 2000 t) 1497 52% 19
Motor Vessels 135 m (2000 - 3000 t) 2135 50% 19
Coupled convoys 163 -185m 2903 61% 17
Pushed convoy - push boat + 2 barges 3000 70% 17
Pushed convoy - push boat + 4/5 barges 8000 70% 10
Pushed convoy - push boat + 6 barges 10000 70% 7.4
Tanker vessels 4195 65% 21
Container vessels 110 m 1410 75% 26
Container vessels 135 m 3141 75% 20
Container vessels - Coupled convoys 2502 68% 20

Source: Smart Freight Centre & STC-NESTRA. GHG Emissions Factors for Inland Waterways Transport.
(2018).
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Annex 2 Comparing fuel-based and activity-based approaches

Table 22 Comparing fuel-based and activity-based approaches

Approach Fuel-based approach Activity-based approach

Calculation
equations

Key data
needed

Emission
factors

Total CO, emissions =

> (quantity of fuel consumed (liters or
gallons) x emission factor for the fuel
(e.g., kg COe/liter))

+

sum across grid regions:

> (quantity of electricity consumed
(kWh) x emission factor for electricity
grid (e.g., kg CO,e/kWh)

If fuel data is not available, users may
calculate the quantities of fuel
consumed using fuel spend or from
distance travelled.

1) Calculate fuel use from fuel spend
Total fuel use =

total fuel spend (e.g., $)/ average fuel
price (e.g., $/liter)

2) Calculate fuel use from distance
travelled

Sum across transport steps:

X (total distance travelled (e.g., km)

x fuel efficiency of vehicle (e.g.,

liters/km))

Allocated fuel use =
total fuel consumed (e.g., liters) x

Mass/Volume of goods transported

[mass/volume of company’s goods ]

Source: GPC

- Quantities of fuel consumed;

- Amount spent on fuel and average
cost of fuel; and

If applicable:

- Actual distances provided by
transportation suppliers;

- Average fuel efficiency of the
vehicle, expressed in units of fuel
consumed per kilometer;

- Mass of goods transported,;

- Information on whether the products

are refrigerated

- Fuel emission factors, expressed in
emissions per unit of energy
consumed (e.g., kg COe/liters)

- For electric vehicles (if applicable),
electricity emission factors,
expressed in emissions per unit of
electricity consumed (e.g., kg

ICLEI EcoLogistics Self-Monitoring Tool User Guide (Version 2.0)

Total CO, emissions across transport
modes and/or vehicle types =

> (mass of goods transported (tons)

x distance travelled (kilometers)

x emission factor of transport mode or
vehicle type (kg CO.e/ton or
volume/kilometer)

Source: GPC

- Mass or volume of the goods
transported,;

- Actual distances provided by
transportation suppliers;

- Average fuel efficiency of the
transport activity, expressed as fuel
consumed per t-km;

- Information on whether the products
are refrigerated

- Emission intensity factor by mode of
transport (e.g., road, rail, inland
waterway ) or vehicle/vessel types
(e.g., articulated lorry, container
vessel), expressed in units of
greenhouse gases equivalent (CO.e)
per unit of mass (ton) or volume
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Advantages

Disadvantages

Challenges

CO0,e/kWh)

It differentiates emissions and fuel
consumption by vehicle type

It gives an accurate representation
of the CO, emissions from the
overall freight vehicle fleet;
Ease-of-use and potentially small
data needs that are a closer match
to company data

Less time-consuming to conduct
Lack of technological detail
Time-consuming to disaggregate
vehicle fleet into specific vehicle
type, if not done already

Gathering reliable data on fuel use and
vehicle activity from companies can be
challenging.
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travelled (e.g., km)

- It differentiates emissions and fuel
consumption by vehicle type

- It can produce detailed data for
urban freight transport and transport
planning

- Takes input at a more aggregated
level that matches typical economic
or general transport activity surveys

- Can be resources-intensive and
time-consuming

- It requires different data collection
needs than the fuel-based approach

Gathering data about transport activity

(distance travelled plus vehicle loading)

and vehicle characteristics can be

challenging.
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Annex 3 Important calculation parameters

Unit Mass (kg) or volume (liter or gallon)

Description Amount of fuel used by the vehicles in the city based on fuel type and vehicle type

Data source Data source Conditions for using data source

\e/\gt]ier:ating A. Data from the logistics companies or BIEENEE 2oLl

fuel use, the carriers, in the form of fuel receipts

following B. Estimates of fuel purchases [ ot e lelolis

sequence is . ) If A is not available; Values should be

often used: € ey pialienee) s based on well-documented and reliable
sources.

Remarks For freight road transport, different fuel types are used: including diesel, gasoline,

electricity, hydrogen, other diesel oils, CNG, LNG and biodiesel.

Parameter Fuel emission factor

Unit Kg COze/kg fuel
Description Mass of CO,e released for fuel used
Data source Data source Conditions for using data source

. Preferred source
A. Direct measurements from real

vehicle operations
B. Modeled data If Ais not available
If A is not available; Values should be
based on well-documented and reliable
sources.
If A is not available; It is accepted
practice to use representative values
which are based on the most credible
sources and are developed by
specialists.

C. National emission factor sources

D. Standard values from international
standards, databases and
methodologies with a particular
focus on the logistics sector, such as
the GLEC Framework

Remarks Whenever possible the factors have been chosen with the aim of maximizing overlap
with existing transportation standards, published sources and national standards.
However, it must be noted that the values cannot be guaranteed, actual emissions
may vary widely depending on the efficiency of the fuel production and distribution
systems.

| Parameter  |Weight . |
Unit Ton
Description The amount of goods being transported
Data source Data source Conditions for using data source

A. Actual shipment weight data from Fireiieria e

invoices, bill of lading data from
transport companies or other
company records

B. Estimated weight based on the mass AR ReraElEE

of cargo
Remarks
 Parameter [ Distance |
Data unit Kilometer (km)

Description Vehicle kilometers travelled (VKT)
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Data source  Four common approaches to calculating distance are as follows:
Approach Conditions for using data source
Preferred source, but generally only
known by the carriers
If A is not available; It is widely accepted
and tends to be the shortest distance by
taking into account real operation
conditions
If A is not available; Usually do not reflect
real operating conditions
Currently focused on the air transport; It
is the shortest distance between the start
and end point.
Other sources of data: Roadside traffic surveys; Origin-Destination (O-D) surveys;
Historical data from the city
Remarks The actual distance travelled should be taken into account; however, in the majority
of cases only vehicle operators have information about VKT. Thus planned distance
is usually used for road transport calculation.

A. Actual distance

B. Planned distance

C. Shortest feasible distance (SFD)

D. Great circle distance (GCD)

Whenever possible, data from existing O-D surveys or other local studies should be
accessed and used to determine the freight vehicle distance travelled.

Ton-kilometer

Unit Ton-kilometer (t-km)

Description It represents the transport of one ton of goods over a distance of one kilometer.
Data source = Measurements or data from existing surveys

Remarks It should be noted that ton-kilometers should be calculated separately for different

fuel types and transport services.
For some modes and commodity types it would be more appropriate to measure

freight movement in terms of volume rather than weight. However, the statistics on
the volume of freight is often lacking.

Load factor

Unit Percentage (%)

Description The degree of utilization of the maximum payload capacity of a vehicle

Data Data source Conditions for using data source
source

. . Preferred source
A. Primary data from carriers

B. Estimated year averages based on I et aellalalte

national statistics for different types of
vehicles
Remarks The amount of fuel consumed, hence the emissions emitted is very sensitive to load
factors, particularly in the case of road transport.

Empty running

Unit Percentage (%)

Description Calculated as a percentage of total vehicle-kilometers that are run empty

Data Data source Conditions for using data source
source Preferred source

A. Primary data from carriers

B. Estimated year averages based on 7 tsmes ekl

national statistics for different types of
vehicles
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Remarks The average load factors and empty running affects the amount of freight traffic
required to move the t-kms.

Number of registered vehicles
Unit Number
Description The number of vehicles registered in the city

Data Vehicle registration database in the city
source
Remarks Many vehicle registration databases do not deregister vehicles that are scrapped or out

of service. This might give higher emission factors to the calculation.
When most vehicles are registered in the city, the emissions are often calculated from
the active population of vehicles registered multiply by annual VKT per vehicle.

Emission intensity factors

Unit kg CO,e/ t-km
Description Expressed as the total CO,e emissions divided per ton-kilometers; used to describe the
CO.e intensity of freight transport

Data Data source Conditions for using data source
source . . Preferred source
A. Direct measurements from real vehicle
operations

Modeled data If A is not available

If A is not available; Values should be
based on well-documented and reliable
sources.

If A is not available; It is accepted practice
to use representative values which are
based on the most credible sources and
are developed by specialists.

C. National emission factor sources

D. Standard values from international
standards, databases and
methodologies with a particular focus
on the logistics sector, such as the
GLEC Framework

Remarks Default factors for various types of vehicles are included in Annex 1. Standard values
for empty running and load factors are embedded within the default factors.

Other emission intensity metrics include: kg CO,e per TEU-kilometer, ton, kilometer,

TEU, shipment, item, revenue, TEU/ton throughput, container lifts.
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Abbreviation

CNG Compressed natural gas
(6]0] Carbon monoxide

Cco, Carbon dioxide

CO,e Carbon dioxide-equivalent
GCD Great Circle Distance

GDP Gross domestic product
GLEC Global Logistics Emissions Council
GHG Greenhouse gas

GVW Gross vehicle weight

HDV Heavy-duty vehicles

ITF International Transport Forum
kg Kilogram

kWh Kilowatt-hour

LDV Light-duty vehicles

LHDT Light heavy-duty vehicles
LNG Liquefied natural gas

LPG Liquefied petroleum gas
MDO Marine diesel oil

MDV Medium-duty vehicle

NO, Nitrous dioxide

NMT Non-motorized transport
(O] Ozone

PM, 5 Fine particulate matter
PM;, Particulate matter

S0, Sulfur dioxide

TEU Twenty-foot equivalent unit
TTW Tank-to-wheels

VKT Vehicle kilometer traveled
WTT Well-to-tank

WTW Well-to-wheel
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Glossary

| Name | Brief description

Activity-based
approach

Activity data

Base year

Baseline scenario
Business- as-usual (BAU)
scenario

Cargo

CO, equivalent (CO.e)

CO.e intensity factors

Emission

Emission factor

Empty running

Ex-ante

Ex-post

Freight transport demand

Fuel life cycle

Fuel-based approach

Greenhouse gas (GHG)
Load factor
Mitigation action

Parameter
Payload

Scope 1 emissions

Methodology that provides measurement of activity, such as vehicle
miles traveled or ton-kilometers moved, which is multiplied by an
emission factor to estimate total emissions. Well-suited for planning
situations and Scope 3 calculations.

A quantitative measure of a level of economic activity that results in
greenhouse gas (GHG) emissions. Activity data are multiplied by an
emission factor to estimate the GHG emissions associated with a
process or an operation.

A specific year of historical data against which emissions are compared
over time.

Baseline scenarios are projections of GHG emissions and their key
drivers as they might evolve in a future in which no explicit actions are
taken to reduce GHG emissions.

A reference case that represents future events or conditions most likely
to occur as a result of implemented and adopted policies and actions.
Sometimes used as an alternative term to “baseline scenario”.

A collection or quantity of goods carried on a means of transport from
one place to another; cargo can consist of either liquid or solid materials
or substances, without any packaging (e.g. bulk cargo), or of loss items
of unpacked goods, packages, unitized goods (on pallets or in
containers) or goods loaded on transport units and carried on active
means of transport.

Carbon dioxide equivalent is a unit that describes the impact of different
greenhouse gases as a single measure related to the global warming
potential of carbon dioxide.

A way to express the CO,e intensity of freight transport; expressed as the
total CO,e emissions divided by the total work done, expressed in ton-
kilometers

The release of GHGs into the atmosphere.

A carbon intensity factor that converts activity data into GHG emissions
data, usually given ins gram carbon dioxide equivalents per kilometer (g
COze/km)

Empty running is calculated as the percentage of total vehicle-kilometers
that are run empty.

Analysis that is done before an intervention is taken.

Analysis that is done after an intervention is taken.

A measure of the volume of freight transport, typically expressed by ton-
kilometer.

The various stages from the production to the use phase of fossil and
alternative fuels.

Methodologies that use actual fuel consumption data to estimate
emissions, based on the content of the fuel and assumptions regarding
its combustion.

Gases that trap heat in the atmosphere, including Carbon dioxide (CO,),
Methane (CH,), Nitrous oxide (N,0), and Fluorinated gases.

Load factor is the ratio of the shipment weight to the payload capacity of
a vehicle or vessel.

A policy, program, project or measure that is expected to reduce GHG
emissions if it is implemented. A mitigation action is an intervention

A variable that is part of an equation used to estimate emissions.

The payload of a truck is the total weight minus the actual weight of the
vehicle and is equal to the vehicle load capacity.

GHG emissions from sources located within the city boundary.
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| Name | Brief description

Scope 2 emissions
Scope 3 emissions

System boundary

Ton
Ton-kilometer (t-km)

Vehicle kilometers
travelled (VKT)
Upstream emissions

GHG emissions occurring as a consequence of the use of grid-supplied
electricity, heat, steam and/or cooling within the city boundary

All other GHG emissions that occur outside the city boundary as a result
of activities taking place within the city boundary.

Definition of the limits of coverage of a calculation - in the case of the
GLEC Framework limited to an assessment of which phases of the
transport supply chain are and are not included in a particular transport
system.

Metric unit of mass equal to 1000 kilograms.

A unit of measurement of goods transport which represents the
transport of one ton of goods over a distance of one kilometer. Ton-
kilometers is also written as ton-km or t-km in tables

and formulae.

Distance travelled by a vehicle multiplied by number of vehicles.

Emissions linked to energy operational processes such as extraction or
cultivation of primary energy, refining, transformation, transport and
distribution of energy.
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